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1. General Description  

1.1. Development History 

The original software named Spekwin (16bit version) was developed in the Daltrozzo group at 

the Universität Konstanz in 1997-1998 by Dr. Claus Vielsack with DELPHI1. It was based on an 

even earlier attempt to create software for spectra display undertaken by Dr. G. Kollmannsberger 

with TURBO PASCAL (DOS program tpbld.exe, until 1994). Since 1999, further development is 

done by me. At present there is the 32bit-Version Spekwin32 (developed with DELPHI 4) with 

enhanced functionality and much increased working speed for some functions. A big part of  the 

work took place during my PhD time at the Daltrozzo group from 2000-2005. Development 

speed went down somewhat afterwards. Since 2010, many new functions have been introduced. 

1.2. Description 

One main goal of  Spekwin32 is the consistent display of  spectra coming from different sources. 

At the moment, about 36 different spectral file types from commercially available spectrometer 

systems can be read. By using Copy&Paste via the clipboard, arbitrary data can also be intro-

duced into Spekwin32 for fast visualization. Unknown binary files can converted into ASCII data 

for a first attempt of  reading their content. Spekwin32 is able to handle UV/VIS, fluorescence, 

NIR, IR and Raman spectra while the main focus is on UV/VIS and fluorescence.  

 Spekwin32 allows doing many tasks on (series of) spectra that come across in the laboratory 

everyday life (baseline correction, spike removal, normalization, smoothing, averaging, integra-

tion, finding peaks and determining FWHM, showing peak labels, calculation of  concentration 

via Lambert-Beer, absorption coefficient and oscillatory strength, create Raman shift spectra ...). 

As important features for fluorescence spectroscopy there are: calculation of  degree of  polariza-

tion, center of  gravity, fluorescence quantum yield; correction of  excitation intensity of  fluores-

cence spectra, calculation of  excitation spectra from two-dimensional fluorescence spectra, 

removal of  Rayleigh and Raman peaks from EEM data, subtraction of  Blank EEM data, display-

ing two-dimensional fluorescence spectra (EEM) from series of  fluorescence or excitation spec-

tra. The EEM functions are useful for pretreatment of  data intended for chemometric analysis. 

To simulate absorbance spectra, there is an algorithm that allows fitting of  any group of  Gauss 

curves to present spectra. 

For simple documentation, any number of  spectra can be saved together as proprietary 

Spekwin32 binary file or as two sorts of  human readable ASCII files (*.dat and *.csv). Spectral 

data can also be exported into two commonly accepted spectra file formats: JCAMP-DX and 

THERMO Galactic/GRAMS spc files. A batch export function allows to convert hundreds of  

spectra from all file formats into single spectrum *.dx, *-spc and *.csv files.  Gemologists will like 
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the possibility to export Raman spectral data into RRUFF format. The current plot can be print-

ed, copied to the clipboard or saved as graphics (WMF, GIF, TIFF, BMP, and PNG). For LaTeX 

freaks, Gnuplot parameter files and data files can be created that allow producing EPS files 

directly. The current’s plot spectral data can also be copy&pasted via the clipboard. 

1.3. System Requirements/ Installation  

Spekwin32 will work with Win XP/Vista/7/ 8.1/ 10. Hardware requirements are minimal. The 

downloaded file will install the full english version, including the HTML manual. There is also a 

german version available. Please run the installation in administrator mode, otherwise reading of  

*.spc files will not work.  

1.4. Terms of Use 

Spekwin32 is provided as freeware for non-commercial, private, academic and educational use, 

this includes also non-profit organization (i.e. schools, universities, UN organizations, public 

authorities, police, fire brigade, hospitals). In this case, you are granted the right to use and to 

make an unlimited number of  copies of  this software. 

Commercial use is not authorized without agreement or ordering. After an appropriate 

trial period, you will have to purchase a one-time licence. This licence entitles you to get 

free updates and free basic mail support. A single licence is valid for either a single user 

on several computers or several persons on a single computer, but not for several persons 

on several computers. Licence purchase and payment is done via Mycommerce/ ShareIt 

the single licence price is 210€ (excluding VAT), there are also volume discounts. 

Spekwin32 is copyright-protected. The software is only available via the author's website, no one 

else is allowed to distribute it or sell it, except with the author's permission. The software must 

not be modified; you may not decompile or disassemble the software or any parts of  it.  

Spekwin32 is provided "as-is" and without warranty of  any kind, express, implied or otherwise, 

including without limitation, any warranty of  merchantability or fitness for a particular purpose. 

In no event shall the author of  this software be held liable for data loss, damages, loss of  profits 

or any other kind of  loss while using or misusing this software. 

1.5. Scientific citations 

If  you use Spekwin32 in your scientific work, please reference to this software as: 

F. Menges "Spekwin32 - optical spectroscopy software", Version 1.72.0, 2015, 

http://www.effemm2.de/spekwin/ 

Please insert the current version number and the year of  compilation from the Help => about 

Spekwin32... window. You may leave out the part in quotation marks. 
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(And please: try to get the spelling right! It's not "Specwin-32" and not "Speckwin 32", there is no 

blank and no hyphen between "Spekwin" and "32", just write Spekwin32!)  

2. Main Window and Main Menu 

2.1. Main Menu 

All functions (except Zoom/Rescale) are accessed via the Main Menu.  

2.2. Icon Bar 

Some of  the more important functions can also be accessed via the icons of  the Icon Bar. The 

function of  icons is shown with the mouse pointer shortly hovering above them. 

2.3. Graph Window 

The Graph Window is always visible, consisting of  axes with axis titles, loaded spectra and legend 

with corresponding legend texts. As x axis types, there can be wavelength, wavenumbers, Raman 

Shift and Electron Volts; as y axis types, there is transmittance (or reflectance), absorbance (or 

intensity), epsilon or log(epsilon) available. When no spectrum is loaded, there are no axis titles. 

 Axes might be changed in [Plot/Options]→[Axes]. The font of  axis ticks might be changed in 

[Plot/Options]→[Axes Font], the font of  axis titles and legend titles might be changed together in 

[Plot/Options]→[Legend Font]. These might also be permanently changed in [Plot/Options]→ 

[Configuration]. The properties of  spectra display (colour, line type, line width) and the corre-

sponding text of  the legend title can be changed in [Spectra]/[General].  

The mouse buttons are for zooming in and out. Select the zoom range with the left mouse 

button. The program then zooms in to the next axis ticks for a straight axis numbering.  The 

middle mouse button redraws the graph window. The right mouse button does a rescale, all 

spectra will be displayed completely.  

The legend box can be moved with the left mouse button. It might be hidden with 

[Plot/Options]→[Legend on/off]. 

2.4. Status Bar 

The Status Bar at the lower edge is divided in three parts: 

 On the left, the current number of  loaded spectra is shown. 

 On the middle, various program messages will be shown. 

 On the right, the current mouse position (x axis | y axis) is continuously shown in units 

of  the graph axes. 
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3. The FILE Menu  

The File menu contains all functions to Open, Save, Print and Export spectra. 

At the bottom you will find a list of  the most recently used Spekwin32 files ( only *.spv files).  

3.1. Menu Item [Open]  

Several files can be selected simultaneously in the usual manner. While loading the selected 

spectral files, the status of  the reading procedure is displayed in the middle part of  the status bar. 

If  possible, the x and y axis types are chosen according to the most recently opened spectral file. 

The following file formats are currently recognized (you will find a collection of  sample files at 

the Spekwin32 website): 

*.abs 

*.trm

*.ssm 

*.irr 

*.lib 

  ASCII file format of  StellarNet’s SpectraWiz software. File extensions explained: 

.abs  - Absorbance  

.trm  - Transmittance  

.ssm  - Scope Mode  

.irr  - Irradiance Mode (could be any unit from Watts to Candela)  

.lib  - a library file for LIBS and Raman 

*.asc : • ASCII file format of  absorption spectra of  the Milton Roy MR3000 diode array 

absorption spectrometer. The y axis type of  the file is detected automatically.  

• ASCII file format of  absorbance spectra of  the Beckman Coulter DU 600/7000 

absorption spectrometers.   

• ASCII file format of  USGS spectral data base. 

*.csv : ASCII file format (csv = comma separated values) of  spectra from different sources: 

• Absorbance spectra of  the Varian Cary 50 absorption spectrometer (Software: Cary 

WinUV). Spectra in transmittance and absorbance will be read.  

• Absorbance spectra of  the Hewlett Packard 8453 absorption spectrometer.  

• IR spectra of  Bio-Rad FTS 3000 MX spectrometer (software: Varian Resolution Pro) 

• Absorbance spectra of  Scinco Neosys 2000 spectrometer (Software: Lab Pro Duo) 

• Absorbance spectra of  WTW photoLab spectral software  

• Absorbance spectra of  the Thermo Electron Helios Alpha spectrometer  

• multicolumn (1 – many), multiformat (all spectral types) csv file, produced by 

Spekwin32 itself 

*.dat 

 

: Spekwin32 ASCII file format. Contains any number of  spectra together with their 

legend title. The program always takes the y values as absorbance, so be careful if  you 

saved spectra in a different y scale type. 

*.dsp  Binary file format of  spectra from Ascanis Lambda-SPX/ VISIONlite software 
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*.dx : JCAMP-DX 4.24/5.00 –file format of  UV/VIS, Raman and IR spectra. NMR and MS 

spectra will not be read!! DIFDUP and ASDF coded spectra will not be read either. 

Tested Perkin Elmer software: UVCSS & FLDM (DOS software), UV-Winlab & FL-

Winlab. Further Test spectra were available from Bio-Rad DigiLab, Mattson Instru-

ments, Galactic Industries Lab Calc and GRAMS, Sadtler, Jasco HPLC System, NIST 

Chemistry WebBook, the IUPAC JCAMP site and Robert J. Lancashire’s JCAMP site. 

*.fak : Simple ASCII file format for import of  your own data. Tab separated XY Pairs, one 

pair per line, point or comma as decimal separator, optional header: if  the first line 

reads wavenumbers or 1/cm or cm^-1 or cm-1 the x axis type is assumed to be wave-

numbers, default is wavelength in nm. Also tries to detect y axis type. Automatic query 

dialog for axis types if  unclear from file. 

*.ggg : File format of  one of  our home built spectrometers. 

*.jws  Binary file format from JASCO spectrometers.  

*.prn : • ASCII file format of  Princeton Instruments WinSpec 1.6 (16Bit) software for CCD 

cameras from Princeton Instruments. Save in Winspec as ASCII-1 or ASCII-XY. 

• ASCII export file format of  Horiba DataMax software. 

*.proc

spec 

 Binary file format from Ocean Optics SpectraSuite software, internally the format is 

called “OOIBinary” 

*. 

rruff 

 ASCII file format of  Raman spectra from the RRUFF online mineral database. 

*.scn  Binary file format of  absorbance spectra of  the Beckman Coulter DU 600/7000 

absorption spectrometer.s. 

*.sp : Binary and ASCII file formats of  absorbance, fluorescence, IR & Raman spectra of  

PERKIN ELMER spectrometers. Tested Software: UVCSS (DOS software), CFS 

(DOS software for LS-3B, LS-4B and LS-5B), UV WinLab, FL WinLab. Perkin Elmer 

Raman test spectra were available from S. B. Engelsen’s Database on Raman Spectra 

of  Carbohydrates. Fluorescence spectras’ ordinate values get divided by 250 before 

they are displayed. 

*.spc : • Binary file format from SHIMADZU UV-1600 and UV-1800 spectrometers 

• Thermo Fisher’s binary spectral file format (originating from Galactic Industries Corpo-

ration). Software: GRAMS/AI. Quasi standard used by quite a lot of  other vendors (e. 

g. Ocean Optics, Jobin Yvon Horiba). Tested spectral types: UV/VIS, NIR, FTIR, 

Raman, fluorescence. Will not read spc files from EDAX XRF analyzers, this is a 

different file format. For those files, use the “EDAX Spectrum Viewer”. 
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*.spe : Binary file format of  Roper Scientific / Princeton Instruments WinSpec/WinView 

Software (16bit and 32bit). Possible x axis types are wavelength, absolute and relative 

wavenumbers (for Raman spectra). 

*.spk  ASCII file format of  absorbance spectra of  the IKS XDAP diode array absorption 

spectrometer (IKS is now axeon in Oberhausen/Germany). 

*.spv : Spekwin32’s own binary file format. Contains arbitrary numbers of  spectra. Legend 

titles and other properties of  individual spectra are saved.  

Changed file format in versions 1.68.1 and 1.69.2! Earlier program versions are not 

able to read later *.spv spectral files.  

*.trt 

*.tat 

*.ttt 

*.tit 

 ASCII file format of  the Avantes software. Tested: Avantes SpectraWin Basic 5.0 and 

Avantes Avasoft 6.1. Measuring modes are:  

trt: “Scope”  

tat: “Absorbance”  

ttt: “Transmittance”  

tit: “Irradiance” 

*.wls  ASCII format of  VWR UV-1600PC spectrometers, software: “M.wave professional” 

3.2. Menu Item [Open unknown binary file] 

This menu item will assist you in getting out spectral information from binary files with unknown 

data formats. After opening your unkown file, a pre-formatted Excel template file opens. The 

unknown file’s content has been put to the clipboard. Please paste this to cell A1 of  the Excel 

template. The first line shows your file’s name and filepath. The columns show the file content 

“as-if ” the data was in a certain number format (as there are integer and float types coming with 

different byte sizes and Endianness). Useful content could show up in any column, normally 

block-wise. By conditional formatting, the template highlights datablocks with useful numbers. 

3.3. Menu Item [Paste Data from Clipboard] 

With this feature, you can transfer arbitrary data from Excel or Origin or even any text editor into 

Spekwin32. It is only required that there are at least two columns, where at least one contains the 

x axis values. Just select the desired range of  data, and copy&paste into Spekwin32. It will work 

with multiple columns, “x y y y” and “x y x y x y” arrangements are accepted. Axis types can be 

defined in the line above the data columns. Default types are “wavelength” and “absorbance”, if  

no other information is detected. Optionally, there can be names for the spectra in the line above 

the axis type descriptions.  

Hint: Within Excel, use the keyboard shortcut CTRL+SHIFT+Arrow(down, or right) for 

automated selection of  whole data blocks. Do not select completely empty columns. 
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3.4. Menu Item [Save]  

This menu item will save the current content of  the graph window.The graph will be saved with 

the file name and file type from the last use of  [Save as...]. On first use, "Save as..." dialog will 

appear.  

3.5. Menu Item [Save Data as]  

Used for saving the data of  currently displayed spectra. A "Save as..." dialog appears for file name, 

type and path. 

There are 5 data file formats to select from: 

 spv files for fast and space-saving storage and reading in again of  spectra in any composition. 

 spc files for saving of  single spectra in Thermo Fisher's quite common file format.  

 dx file for saving single spectra in the world-wide used, IUPAC-proposed standard file format 

JCAMP-DX.  

 dat files for import of  values into graphing programs like Origin or Sigmaplot. Multiple 

spectra get interpolated onto a single common x column. 

 csv fore easy export of  the original spectral data for Excel and the like. Multiple spectra 

contained as separately xy paired columns. 

3.6. Menu Item [Save for RRUFF] 

For saving Raman spectra into the native data file format for the RRUFF minerals database 

(http://rruff.info/about/about_download.php). Their software CrystalSleuth allows to create 

and maintain your own searchable minerals Raman spectra database. 

Select the spectrum to be exported in the upper dropdown list, and use either the parameters 

from the input file or else put them in yourself. The [Save] button will save the selected spectrum 

in *.rruff  format. Quit the window with the [Close] button when finished. 

3.7. Menu Item [Batch Export Data] 

This feature allows to export all loaded spectra as single spectrum files in three file formats 

(*.spc, *.dx, *.csv). Additionally, all spectra can be exported together as multi-file (same file 

formats).  

 export data as individual single spectrum files or else as common multi-file. 

 file location: choose to save the files in the same location (the filepathes where the original 

spectrum files were located), or else together at the filepath defined in the edit box below. 
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 A new file name can be defined together with attached successive numbering, or else the 

legend texts can be used as filenames. Both options get combined, when selecting both. 

The [Export!] button starts the file export process; the progress will be shown in the text field 

and with a progress bar below.  

3.8. Menu Item [Save Plot as] 

Used for saving current spectra as spectral plot. A "Save as..." dialog appears for file name, type 

and path. 

There are 5 graphics file formats to select from: 

 csv fore easy export of  the original spectral data for Excel and the like. Multiple spectra 

contained as separately xy paired columns. 

 gif files for saving as internet usable pixel graphics, compressed files, 256 colours, resolution: 

1350x900 pixels. 

 bmp files for saving as lossless pixel graphics, big files, resolution: 1024x768 pixels. 

 wmf files for saving as freely scalable vector graphics of  small file size, recommended best  

use for Windows Office applications like MS Word or MS PowerPoint. 

 tif files for saving as rather small lossless compressed files with 32bit colours, best for print-

ing, resolution: 1350x900 Pixel. 

 png files for saving as small lossless compressed files, the internet picture format of  the 

future, resolution: 1350x900 Pixel. 

Hints for optimized graphics export: 

 With high resolution screen and maximized program window, the standard axes and legend 

fonts might look rather small in saved graphics. Try saving again with mid-sized Spekwin32 

window. 

3.9. Menu Item [Save for Gnuplot]  

Creates two files with the same name: a Gnuplot parameter file (*.plt) and a second file (*.tat) 

with the spectral values. The parameter file contains the necessary commands for Plot Title, Axes 

titling and scaling, second X-Axes, second Y-Axes (if  degree of  polarization is included), position 

of  the legend box and creation of  EPS file with the same name. Before saving, there is a dialog 

for configuration of  these parameters where additional commands can also be included. 

For this function the following parameter files must exist in the program folder : gexit.plt, ginit.plt, 

ginit2.plt, ginit2d.plt, pola36.plt, polaset.plt, postcol.plt, postmon.plt, wlachse.plt, wlachse2.plt. This function 

was tested with Gnuplot 4.6 for Windows (32bit).   
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3.10. Menu Item [Copy Data to Clipboard] 

Copy all data from all current spectra to the clipboard. From there, it can be pasted into text 

processing or spreadsheet software (like MS Excel or Origin).  

Spectral data will be saved in x..y..x..y..x..y.. format (each spectrum has its own paired xy values). 

In case all spectra have the same x values, the format will be x..y..y..y.. (that is: one x column for 

all spectra). The first line contains the legend texts, second line contains x and y format for each 

spectrum. 

3.11. Menu Item [Copy Graphics to Clipboard]   

The current graph window is copied as a vector graphic to the clipboard. From there, it can be 

pasted into graphic or text processing software. For optimized graphics see hints in chapter 3.5.   

3.12. Menu Item [Print]  

Prints the current graph window. Select installed printers like usual. For optimized graphics see 

hints in chapter 3.5. PostScript files (*.ps) can be produced by printing to a file with a PostScript 

printer driver.  

3.13. Menu Item [Exit] 

Terminates the program. Unsaved spectra are lost! 

 

The SPECTRA Menu 

3.14. Menu Item [General]  

Here you can change all parameters important for the display of  spectra. Further, the absorption 

path length can be set and the sample concentration can be calculated from molecular weight, 

sample weight and solvent volume.  

All values displayed and entries made belong to the current spectrum, selected in the drop down 

list at the top. The current spectrum displays as a thicker line in the Graph window. 

 Legend Title: can be changed in the upper drop down list for each spectrum. With <Up> 

and <Down> keys you can scroll through the list of  Legend Titles, the same works with the 

dialog’s [<= Back] and [Forward=>] buttons. Of  course, spectra can also be directly selected 

in the upper drop down list. All entries are automatically updated on making changes to the 

selected spectrum. With [Replace by filename] the legend title of  the selected spectrum will be 

replaced by its filename.   
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 With [Change all titles...] you can work on all legend titles in a single window. The '#' character 

may be used as a wildcard with search/replace. There, it is also possible to replace the legend 

texts by their file names. 

 Line Width: can be set for any spectrum in relation to the general line width which is 

changed in menu items [Thicker lines] and [Thinner Lines]. For exporting as graphics and print-

ing, it is recommended to select line widths from 2 to 5, depending on the outcome of  the 

printed graph. 

 Temperature: For some spectral file types (*.ggg, *.gdm, *.gkl, *.gpo) the measuring temper-

ature is shown. You may enter your own values. 

 Wavelength: For some spectral file types (*.sp, *.ggg, *.prn, *.spe) the wavelength is shown 

(excitation wavelength for fluorescence spectra, detection wavelength for excitation spectra). 

You may enter your own values. The only commercial file type having it's wavelength inside is 

*.sp (Perkin Elmer fluorescence spectra). 

 Line Type: there are three line types possible which can be set for each spectrum separately. 

 Line Colour: the line colour of  the current spectrum is shown in the vertical colour field on 

the right. There are 14 different colours in the palette which cycle infinitely. The line colour 

can be set for each spectrum separately with the button [Change colour =>]. There you can al-

so define your own colours. 

 Absorption Path Length: standard value is d 1cm . Changes have an effect on y axis 

scaling with   and log( ) , as well as for calculation of  concentration via the molar decadic 

absorption coefficient with the menu item [Concentration] (4.9). 

 Concentration: standard value is 0 mol/l. For y axis scaling with   and log( )  a concentra-

tion c ≠ 0 has to be entered. After entering values for molecular weight, sample weigth and 

solvent volume, the concentration can be calculate with the button [Calculate]. 

3.15. Menu Item [Information] 

For the spectrum selected in the upper drop down list the following properties are shown: 

filepath, filename, date, description, comment1, comment2, spectrum type, solvent, absorption 

path length, concentration, wavelength, temperature, start wavelength, end wavelength, step 

width, number of  data points.  

 The text in the lower part may be copied. 

3.16. Menu Item [Normalize] 

Normalization in this context means to set the maximum y value of  the spectrum to 1. 
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All spectra are normalized to 1 at their maximum wavelength in the currently displayed x axis 

range. To select a certain maximum for normalization, zoom into an x axis range where this 

maximum is the highest. Normalization changes the y values irreversibly and can be done as 

often as you want. This function is very helpful for direct comparison of  spectra.  

3.17. Menu Item [Baseline Correction]  

For offset-correcting of  straight baselines that deviate from zero. Call the function and use the 

mouse zoom function to select the range which should be set to 0. The mean value of  y values in 

the selected region will be subtracted from the spectrum as a constant value. 

 Baseline correction will be done for all spectra at once. 

3.18. Menu Item [Advanced Baselining] 

For cases, where a simple offset baseline correction doesn’t work, this menu function gives 

advanced possibilities. Select the spectrum for adapting the baseline in the upper drop down list. 

The treated spectrum will be added to the list of  spectra. An interactive live preview helps to 

efficiently adapt the baseline. Three different baseline types exist currently: 

 The linear option creates a straight baseline, that can be rotated and shiftet up and down. 

 The adaptive baseline will be most useful for Raman and FTIR spectra, where a slowly 

curving baseline has to be subtracted from a spectrum with narrower peaks. The “coarse-

ness” can be varied, and the result can be shifted up and down. 

 A scattering solution has a baseline continuously rising towards short wavelength values. 

The increase follows a power law, with an exponent depending on particle sizes. The resulting 

baseline can be compressed or expanded vertically and shifted up and down.  

The following settings are available:  

 [treat all spectra] subtracts the created baseline from all loaded spectra. 

 [remove original] removes the original spectrum/ spectra. 

 [keep legend] lets the original legend text unchanged. If  unchecked, “ (baseline corrected)” will 

be added to the legend text(s). 

 [create baseline spectrum] will produce a spectrum from the baseline used. This can be treated 

like every spectrum (save, etc.) 

3.19. Menu Item [Spike Removal]  

When using prolonged exposure times with CCD detectors, artefacts from cosmic radiation are 

increasing. These are called cosmic spikes. 
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 This function detects spikes and interpolates the spectrum in the range of  the spike. All other 

spectral data points remain totally unchanged. Spectra without spikes remain also unchanged. 

Broad spikes (> 5 data points, quite rare), are not detected to make sure not to change spectral 

features. 

Select the spectrum to be treated in the upper drop down list. The treated spectrum will be added 

to the list of  spectra. 

 [Remove Original] deletes the original spectrum. 

 [Treat all Spectra] for treating all spectra, original spectra will be deleted. 

 [Backward spike Removal] lets the detection algorithm move over the spectrum from right to 

left. In this way some more spikes might be detected. 

  [Append "spikes removed"] appends "spikes removed" to the legend titel of  the spectrum. 

3.20. Menu Item [Play] 

This is a just for fun function. The y values are transformed to tone pitches and played from left 

to right via the case speaker. The playing speed is 50 nm/second, independent of  the resolution 

of  the spectrum. 

You might even play real music on selection of  appropiate y values and wavelengths. 

3.21. Menu Item [Smooth] 

For smoothing all spectra at once. The algorithm is equivalent to using Savitsky-Golay smooth-

ing of  third polynomial order from the “Advanced Smoothing” menu item, however smoothing 

intensity depends on the resolution of  spectra (“interval” parameter will be kept between 6 and 

30 points). 

Smoothed spectra are added to the list of  spectra, the legend titles are appended by "smoothed". 

Keep this function in mind to be a suspicious feature, it means modifying and glossing over the 

original data. 

3.22. Menu Item [Advanced Smoothing] 

For better control of  the smoothing behavior. Select the spectrum to be smoothed in the upper 

drop down list. The treated spectrum will be added to the list of  spectra. Three different smooth-

ing types exist currently: 

 [moving average] smoothes by calculating an average value for every data point from a data 

range around this point with the selected interval size. A rectangular or triangular shape can 

be choosen. With the triangular shape, more distant data points are down-weighted. 
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 [Savitsky-Golay] smoothes by calculating a least-squares polynomial interpolation value for 

every data point. The interval size and the polynomial order can be choosen. 

 [Percentile filter] smoothes by identifying the selected percentile for the data points contained in 

the interval size successively for every data point. A lower or upper envelope spectrum results 

upon choosing the 0% or 100% percentile. 

The following settings are also available:  

 [treat all spectra] smoothes all loaded spectra with the selected parameters. 

 [remove original] removes the original spectrum/ spectra. 

3.23. Menu Item [Peaks & FWHM] 

 Select a spectrum in the upper drop down list. In the lower part, a peak table will be shown. If  

possible, the corresponding FWHM (full width at half  maximum) values will be shown. The 

peak finding threshold is variable from 1 – 95%. For finding minima, activate the [ ] inverted 

checkbox. 

 The text in the lower part may be copied with copy&paste by using the mouse or by using the 

button [Copy Peak Data]. 

3.24. Menu Item [Integration] 

After calling this menu item, use the mouse to zoom into the x axis range to be integrated. Left 

and right border of  the zoom box are the integral boundaries. For each spectrum a separate 

message window is shown, containing the boundaries, the integral value of  the spectrum and the 

average value within the selected range.  

 Hint: The oscillatory strength will be shown additionally, if  the axis types wavenumbers and 

absorption coefficient are selected. Of  course, the value of  the oscillatory strength makes sense 

only for selection of  the first electronic transition for integration. The following formula is used 

to calculate the oscillatory strength f:  
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3.25. Menu Item [Cut off Spectrum Part] 

For reducing the spectral range (x scale). Select the spectrum to be cut in the middle drop down 

list and enter the boundaries. The treated spectrum will be added to the list of  spectra. The new 

spectral boundaries will be kept as long as the program runs. 

 with "all spectra of  one type", you can treat all spectra of  a certain type simultaneously. 
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 [remove original(s)] removes the original spectrum/spectra. 

 [prepend "part of:"] prepends "part of:" to the legend titel of  the spectrum/spectra. 

3.26. Menu Item [Sort] 

For changing the order of  loaded spectra.. In the left window, spectra order can be changed 

manually. Use left mouse button for selection (use SHIFT to select multiple spectra). Insert 

selected spectra with the right mouse button (above the spectrum you are pointing to). With the 

option [automatically] all spectra can be sorted automatically by three criteria in both directions: 

 <Direction> can be applied to all spectra (alphabetical and inverse alphabetical available). 

 <Temperature> only for spectra of  our home built spectrometers 

 <Wavelength> for some spectra of  our home built spectrometers and Perkin Elmer *.sp 

spectra, if  measured with a fluorescence spectrometer. For *.spe files, the laser wavelength 

will be displayed, if  they are of  Raman type. Up and down direction available. 

3.27. Submenu [Remove] 

3.27.1. Menu Item [Remove All]  

All loaded spectra are deleted. You have to confirm this before deletion takes place actually. 

3.27.2. Menu Item [Select for Removal]  

For removing arbitrary spectra from the current plot. Select spectra for removing on the left, 

bring them to the right with the button [>]. With [>>] you can bring all spectra from left to right 

at once. The same holds with [<] and [<<] for the opposite direction.  

With the option "remove all spectra of  one type", you can remove all spectra of  a certain type at once. 

3.27.3. Menu Item [Remove Last Spectrum]  

The last spectrum from the spectrum list will be removed. 

 

4. The CALCULATIONS Menu 

4.1. Menu Item [Addition]  

The y values of  the two spectra selected in the drop down list will be added. [all spectra] will 

execute the operation on all spectra present, taking the spectrum selected in the lower dropdown 

list for calculation. The new spectrum will be added to the spectra list, its legend titel will be 

"Addition". [Keep legend text] will retain the original legend text for the resulting spectrum. The 
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new spectrum's start and end wavelength will be determined by the overlapping range of  the two 

selected spectra, the x axis stepwidth is taken from the upper spectrum.  

4.2. Menu Item [Subtraction]  

The y values of  the spectrum selected in the lower drop down list will be subtraced from the y 

values of  the spectrum selected in the upper drop down list. [all spectra] will execute the operation 

on all spectra present, taking the spectrum selected in the lower dropdown list for calculation. 

The new spectrum will be added to the spectra list, its legend titel will be "Subtraction". [Keep 

legend text] will retain the original legend text for the resulting spectrum. The new spectrum's start 

and end wavelength will be determined by the overlapping range of  the two selected spectra, the 

x axis stepwidth is taken from the upper spectrum. 

4.3. Menu Item [Multiplication]  

The y values of  the two spectra selected in the drop down list will be multiplicated by each 

other. [all spectra] will execute the operation on all spectra present, taking the spectrum selected in 

the lower dropdown list for calculation. The new spectrum will be added to the spectra list, its 

legend titel will be "Multiplication". [Keep legend text] will retain the original legend text for the 

resulting spectrum. The new spectrum's start and end wavelength will be determined by the 

overlapping range of  the two selected spectra, the x axis stepwidth is taken from the upper 

spectrum. 

4.4. Menu Item [Division]  

The y values of  the spectrum selected in the upper drop down list will be divided by the y values 

of  the spectrum selected in the lower drop down list. [all spectra] will execute the operation on all 

spectra present, taking the spectrum selected in the lower dropdown list for calculation. The new 

spectrum will be added to the spectra list, its legend titel will be "Division". [Keep legend text] will 

retain the original legend text for the resulting spectrum. The new spectrum's start and end 

wavelength will be determined by the overlapping range of  the two selected spectra, the x axis 

stepwidth is taken from the upper spectrum. 

4.5. Menu Item [Spectra Averaging] 

The y values of  the selected spectra (left mouse button) will be averaged. The new spectrum will 

be added to the spectra list, the legend title can be set in the lower edit field. 

4.6. Menu Item [Y Constants]  

Apply one of  four calculation types to the spectrum selected in the upper drop down list. The 

new spectrum will be added to the spectra list. The following options are available:   
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 with "all spectra of  one type", you can treat all spectra of  a certain type simultaneously. 

 [remove original(s)] removes the original spectrum/spectra. 

 [append "+ | – | × | ÷ | n |"] appends calculation type and figure to the legend titel of  the 

new spectrum/spectra. 

Hint: For multiplication with 2  resp. 4  enter x2 resp. x4 into the edit field. This feature is 

helpful when you have to display fluorescence spectra in wavenumbers. Generally you can multi-

plicate with n  by entering xn (n: real number). The other calculation types are also applicable. 

4.7. Menu Item [X Constants]  

Depending on the selected calculation type, you can move spectra to left/right, stretch and 

compress along the x axis. This function works only if  the spectrum's original x axis type is 

identical with the currently displayed x axis type in the graph window. The new spectrum will be 

added to the spectra list, its legend title appended by the calculation type and the figure from the 

edit field.  

Hint: Please use this function only if  you really know what you are doing, since it modifies the 

spectra in a rather unusual manner. 

4.8. Menu Item [Derivative] 

The first, second, third or fourth derivative of  the spectrum selected in the drop down list will be 

calculated. The new spectrum will be added to the spectra list, its legend title appended by "x. 

Derivative". The following options are available:  

 with "derive all spectra", you can treat all spectra simultaneously. 

 [remove original(s)] removes the original spectrum/spectra. 

 [smooth before derivation] uses a smoothed spectrum for the derivative function. This feature 

virtually eliminates the influence of  measurement noise. 

Hint: Even higher order derivatives can be obtained by repeated derivation of  derived spectra. 

The smoothing option is strongly recommended for all derivatives higher than the first derivative. 

4.9. Menu Item [Transmittance/Reflectance] 

From two intensity spectra (sample and background/reference), the transmittance or reflectance 

will be calculated after T = I/I0 .  

4.10. Menu Item [Degree of Polarisation] 

When processing polarization dependent fluorescence and excitation spectra, it is often necessary 

to calculate the degree of  polarisation and a reduced spectrum. 
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This can be done from two spectra with different polarizer orientations according to the follow-

ing equations: 
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With:  G : reduced spectrum 

P : degree of  polarisation 

 xI : fluorescence intensity with crossed polarizers 

 yI : fluorescence intensity with parallel polarizers. 

The two spectra are selected in the two drop down lists. The new spectrum will be added to the 

spectra list, the legend title of  the new spectrum consists of  the legend title of  the spectrum and 

the new spectral type. 

To calculate all spectra at once, use the option [all]. This works only for spectra of  *.ggg type.  

4.11. Menu Item [Raman Shift] 

Here you can calculate a Raman shift spectrum from a (fluorescence) intensity spectrum in the 

wavelength scale and by providing the laser excitation wavelength. As the area around 0 cm
-1

 is 

usually distorted due to the laser emission itself, you can define the start wavenumber of  the 

Raman spectrum. Two more options are available: 

 [transform all spectra] applies the transformation to all loaded spectra at once. 

 [remove original(s)] removes the original wavelength spectrum/ spectra from display. 

4.12. Menu Item [Concentration] 

In addition to the menu item [General] (3.14), this is the second possibility to set the concentra-

tion for a certain spectrum. For this function, the molar absorption coefficient has to be known. 

The calculation of  concentration is done via Lambert-Beer (Equation(6)).  

All entered values apply only to the spectrum selected in the upper drop down list. Upon entry 

of  molar absorption coefficient, wavelength and absorption path length, you might calculate the 

concentration with the button [Calculate]. You can enter the maximum of  the current spectrum 

automatically with the button [Insert Peak]. 

Hint: For directly entering the concentration, use the menu item [General] (3.14). 
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4.13. Menu Item [Effective Absorbance]  

For the determination of  fluorescence quantum yields it is important to know the fraction of  

light absorbed by the sample. Due to the finite bandwith of  the excitation light, this has to be 

averaged across the bandwidth range, yielding the "effective absorbance".  

The following formula is used: 
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with ( )A  : absorption spectrum 

 I( )  : bandwidth of  excitation light 

Normally, the bandpass is a triangular function characterized by its center wavelength and band-

width. 

4.14. Menu Item [Center of Gravity] 

For the spectrum selected in the drop down list, the center of  gravity will be calculated. I. e. the 

mean of  x values   resp.   weighted by the y values (absorbances ( )A   resp. ( )A   ) after 

the following equation:  
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 The current x axis range will be used as integration boundaries. The result will be shown in the 

middle part of  the status bar. 

Hint: the center of  gravity in wavelength scale does not correspond to the reciprocal center of  

gravity in wavenumbers scale: 
1

    ! 

4.15. Menu Item [Film Thickness] 

From a white-light reflectance spectrum spectrum showing interference, the thickness of  a 

single-layer thin film can be calculated. As input values, the refractive index of  the film material is 

needed together with the incident angle of  the reflected light (perpendicular illumination means 

an angle of  0°). The wavelength range used can be changed. 

The results window contains the input data, the number of  evaluated peaks and the calculated 

thickness together with a quality measure (StDev). A StDev value higher than a few percent of  

the thickness value indicates an invalid result. 
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Hint: This is a new and experimental feature; user feedback is strongly needed and important for 

the future development of  this feature! Do not use this method without cross-checking the 

results by an alternative method! 

4.16. Menu Item [Quantum Yield]  

This menu item is too complicated to explain here. Ask me directly for explanations. 

4.17. Menu Item [Low Temp. Quantum Yield] 

A useful explanation would go beyond the scope of  this manual.   

5. The Fluorescence/EEM Menu 

5.1. Menu Item [Emission Sensitivity Correction]  

For correction of  the wavelength dependent sensitivity of  detectors of  fluorescence spectrome-

ters. This function yields "true spectra". 

 Load the correction curve with the button [Load correction Curve] (*.fak file, has to consist of  XY 

pairs with sensitivity against wavelength). Select the spectrum to be corrected in the middle drop 

down list. The corrected spectrum will be added to the list of  spectra, the legend title will be 

appended with "corrected". 

 [remove original] removes the original spectrum. 

 [correct all] corrects all loaded spectra and deletes the original spectra. 

5.2. Menu Item [Excitation Wavelength Assignment] 

For useful handling of  a set of  fluorescence spectra as two-dimensional spectrum or EEM 

(excitation emission matrix), each spectrum needs its excitation wavelength assigned. This can be 

entered manually for each spectrum in the menu item [General] (3.14), or automated for a com-

plete set of  spectra from this menu item. Just enter the excitation wavelength of  the first spec-

trum and the excitation step width. In case your EEM set comprises only a part of  the loaded 

spectra, select the first and last spectrum of  the set in the two drop down lists. For naming the 

spectras’ legend texts with the excitation wavelength, activate the “replace spectrum names…” 

checkbox. 

5.3. Menu Item [Correction of Excitation Intensity] 

For correcting the wavelength dependent excitation intensity (lamp spectrum) of  fluorescence 

spectrometers for a series of  fluorescence spectra with known excitation wavelength. 
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Load the lamp correction curve with the button [Load Lamp Spectrum]. Select the range of  spectra 

to be corrected with the two drop down lists. The corrected spectra will replace the original 

spectra, their legend titles will be appended with "Excitation intensity corrected".  

Hint: The wavelength can be entered manually for each spectrum in the menu item [General].  

5.4. Menu Item [Remove Rayleigh/ Raman Scatter] 

Often enough, and especially for samples with low intensity fluorescence, EEMs are distorted by 

scattering peaks. These come from first and second order Rayleigh scattering as well as Raman 

scattering and can’t be fully suppressed even by choosing optimal geometries of  sample container 

and optical pathways. For being further used in chemometrics analysis, scattering has to be 

removed. Traditionally this has been done by setting the scattering regions to zero, but there are 

much better ways to reduce the influence of  straylight.  

This menu item allows to remove all scattering from a whole EEM set at once with this options: 

 [treat all spectra] applies the treatment to all loaded spectra at once. 

 [remove original(s)] removes the original spectrum/ spectra from display. 

 With [replace by] you can replace the values of  the scattering region by 

o zeroes, this is the traditional & most ugly way of  doing it 

o a straight line, which might be better in some cases 

o an interpolated curve, which is most useful, because it give the least distortion. The 

interpolated values have the same noise level as their surrounding 

 set the excitation bandwith of  your spectrometer, this defines the width of  the replaced 

values area 

 [remove Rayleigh peaks (1st order)] removes the scattering intensity around your excitation 

wavelengths (visible because your sample does it) 

 [remove Rayleigh peaks (2nd order)] removes the scattering intensity around twice your excita-

tion wavelengths (visible because your emission monochromator leaks the 1st order scattered 

light into it’s 2nd order wavelength range) 

 [remove Raman peaks (1st order)] removes the scattering intensity around the Raman-shifted 

excitation wavelengths. The wavelength difference is solvent dependent, some solvents can be 

selected from the drop down list. You can include other solvents by editing the file “Raman-

Bands.csv” from the Spekwin32 program folder.  
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5.5. Menu Item [Subtract Blank EEM dataset] 

It might be useful to subtract the fluorescent properties of  a “Blank” sample from the EEM you 

want to analyze. This can be successfully used to remove background fluorescence and also 

scattering peaks.  

In the upper part you can see the dimensions of  your current EEM set. Load the Blank dataset 

to be subtracted with [Load Blank dataset…]. This naturally will only work if  the dimensions of  

both datasets are identical. Optionally, “blank subtracted” can be appended to the legend texts. 

5.6. Menu Item [Show 2D Spectrum (EEM)] 

For two-dimensional display of  a series of  fluorescence or excitation spectra. EEM means: 

Excitation Emission Matrix. The spectra should be connected to a wavelength and be corrected 

for excitation intensity before (see above). 

The current mouse position is shown in the lower left corner as excitation, emission and intensity 

values. On the right there are some options for display. By default, excitation is oriented horizon-

tally, emission goes vertically. This orientation can be exchanged by using the [switch x <=> y 

axes] option. The EEM plot can be copied to clipboard with [Copy => Clipboard].  

You cannot print or save the graph at the moment, there are no axes. 

5.7. Menu Item [Calculate Excitation Spectra] 

For calculating a series of  excitation spectra from a series of  fluorescence spectra. The spectra 

have to be connected to a wavelength and should be corrected for excitation intensity before (see 

above). 

Enter the range and stepwidth of  detection wavelengths for the excitation spectra. Fluorescence 

spectra will be removed if  [Remove Fluorescence spectra] is checked. 

6. The GaussFit Menu 

These functions have been taken over almost unchanged from the 16bit version called Spekwin. 

They are working, but not unimpeachable.  

For simulating spectra with Gauss-type groups of  curves and fitting of  real spectra. Will work 

with wavenumbers only as x axis type. 

6.1. Menu Item [Manually] 

Here the real work is done. A guidance document is available from the Spekwin32 website. 
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6.2. Menu Item [Open] 

To open a previously saved dataset of  Gauss spectra (*.gss). 

6.3. Menu Item [Save] 

To save the current dataset of  Gauss spectra. 

7. The PLOT/OPTIONS Menu 

7.1. Menu Item [Configuration] 

Here you can change and set permanently many program options. The settings are written to the 

file spekwin32.ini in the program folder. Write access is needed for this file! During program 

start, these settings are read from the file. Without write access, the settings can be read but not 

written. It is recommended to install Spekwin32 to a folder with write access.  

With [allow multiple instances] activated, it is not advised to load many spectra at once by double 

clicking within the file explorer. This will open as many Spekwin32 windows as files were select-

ed, which might slow down system performance in an unpleasant way 

7.2. Menu Item [Show Peak Labels] 

Activation of  this menu item will bring up an additional menu bar for all the options connected 

with the automated peak labeling feature.  

 Show label allows to use x or y values or both combined as peak label.  

 Threshold defines the mimimum value for labeled peaks. It’s a percental threshold, cal-

cualated for each spectrum individually. 

 Prominence is a parameter that allows fine-tuning the selection of  peaks for labeling. Works 

similar to the “topographic prominence” parameter used to describe mountain tops. 

 With Digits, you can adjust the number precision of  the displayed values. 

 The angle of  the label text can be varied between all angles from vertical to horizontal. 

 You can either label peaks for all spectra or select a single one. 

Hint: There is no way to individually label peaks! 

7.3. Menu Item [Show Spectroscope View] 

The “Spectroscope View” tries to reproduce the visual appearance of  the measured sample 

viewed through a hand spectroscope. These are still in wide use in some industries, especially 

with gemologists. It might provide helpful to reduce the gap between visual and spectrometric 
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methods. This feature works for absorbance or transmittance spectra as well as for emission 

spectra. 

Activation of  this menu item will show an additional menu bar below the plot for all the options 

connected to the Spectroscope View. A fully blown “rainbow spectrum” is shown, with reduced 

brightness according to the selected spectrum’s absorbing regions.  

 Within the rainbow spectrum, the wavelength scale can deactivated and the tick distance 

changed.  

 The coloured rainbow spectrum can be shown as grayscale representation (For those with 

black&white screens and colourless textbooks ) 

 [Align] causes the upper spectrum plot to be aligned with the lower rainbow spectrum. 

Depending on monitor and window size, this may not always work perfectly… 

 With [activate], the modulation of  the full rainbow spectrum by the measured spectrum 

can be switched on and off. Select the spectrum with the drop down list. 

 With [CopyToClipboard] you can place the current rainbow spectrum into the Clipboard.  

 [Save as..] will save the current rainbow spectrum to the hard disk. 

Hint: Transmittance values above 1 (which make no sense physically) lead to distorted colours. 

Emission spectra should be normalized or kept below 1 for y values, otherwise colors will also be 

distorted.  

7.4. Menu Item [Axes]  

For interconversion of  different axis types and naming of  axis titles. For the x axis, wavelength 

and wavenumbers scale can be selected. Wavenumbers and electron volts are proportional to 

energy. The following equation holds true if  the axis units are nm and 1/cm: 
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 Additionally, axis conversion to electron volts (eV) is possible. The calculation is: 

1eV=8065,5cm-1. There is an option to manually set the x axis boundaries in the [boundaries] 

window. 

The y axis values can be shown as transmittance T, absorbance A, molar absorption coefficient ε 

and log(absorption coefficient) log ε. For interconversion, the following equations are used: 

    logA T     and   A cd       (6) 

For displaying epsilon and log epsilon you have to assign a concentration to the spectrum. This 

can be done in the menu items [General] (3.14) or [Concentration] (4.12). Additionally, the y type 

"Reflectance" and "Intensity" are recognized and handled by Spekwin32. 
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If  possible, the x and y axis types are choosen automatically according to the most recently 

opened spectral file. 

The display of  axis titles can be turned off  with the option [show Axis Title]. Set your own 

individual axis title with [Set Axis Title]. 

The option [Alternating Tick Label] is enabled by default when set in the menu item [Configuration]. 

7.5. Menu Item [Axes Font] 

For changing the font of  both axes' tick labels. 

7.6. Menu Item [Legend Font] 

For changing the font of  both axis titles and of  legend titles. 

Hint: When choosing very big font sizes, the axes titles and axes labels might overlap. 

7.7. Menu Item [Legend on/off] 

For turning on and off  the display of  legend titles. 

7.8. Menu Item [Grid on/off] 

For turning on and off  the grid display. 

7.9. Menu Item [Secondary x-Axis on/off] 

For turning on and off  the complementary second x axis at the upper edge of  the graph window. 

7.10. Menu Item [Points/Lines]  

For switching spectral display as points or lines. 

7.11. Menu Item [Flip X-Axis] 

For switching x-Axis direction. Will affect only the graphics display. Data will be saved in default 

direction. 

7.12. Menu Item [Standard Lines&Colours] 

For setting back spectral display to default values. The colours are set to default order, line width 

to 1 and line style to "solid". 

7.13. Menu Item [Thicker Lines] 

Increase the line width by one. Possible range is from 1 to 7. 
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7.14. Menu Item [Thinner Lines] 

Decrease the line width by one. Possible range is from 1 to 7. 

7.15. Menu Item [Plot All Black] 

Set all spectra’s line colour to black. To go back, call the menu item [Standard Lines & Colours] 

once. 

7.16. Menu Item [Cycling Line Types] 

Sets the line types of  all spectra to alternate between "solid", "dotted" and "dashed". To go back, 

call the menu item [Standard Lines & Colours] once. 

7.17. Menu Item [Display Values] 

Continuously shows the current x and y value for the spectrum selected in the drop down list. 

Close with [Abort]. 

7.18. Menu Item [Background Colour] 

For changing the graph's background colour. The background colour will not be plotted, export-

ed or saved, the background remains transparent!  


